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The TapRecorder is a spreadsheet application designed for touch 
screen devices such as the iPad, iPhone and Windows Surface Pro. It 
also runs on other Windows laptops and desktops, including Windows 
XP, 7, 8 and 8.1, but is not compatible with Windows RT or Windows 
phones. TapRecordings are compatible across devices, so they can be 
developed and tested on Windows PCs and then transferred to and 
used on Apple and Windows tablets.

Like a traditional spreadsheet, the TapRecorder works with data in 
rows and columns, and can calculate formulas and sums. Unlike a tra-
ditional spreadsheet, the TapRecorder has been designed  for devices 
with touch screens and limited keyboard access. The TapRecorder 
includes an innovative "tap count" feature to record data with a tap 
on the screen. It also has a "choice list" feature to select an entry from 
a list with a tap on the screen. These features make the TapRecorder 
ideal for recording data in the field, on the court and on the run.

Data is recorded and saved locally on the tablet/phone/PC with the 
TapRecorder. If an Apple device is being used, the iTunes "File 
Sharing" feature is used to move data to and from the desktop. On 
Windows devices, saved TapRecordings can be moved to and from 
other PCs via network drives or flash memory devices.

The iPad/iPhone version of the TapRecorder is a standard Apple 
"app" which is purchased from and downloaded from the Apple 
App Store. The Windows version of the TapRecorder is purchased 
directly from Dimensional Software and downloaded onto the PC 
from our web site.

This guide illustrates how to use the TapRecorder and its desktop com-
ponents. This includes details on how to run existing TapRecordings 
as well as how to set up custom TapRecordings. It also describes how 
to use iTunes File Sharing to transfer data to and from the desktop.

Introduction
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Run the TapRecorder
Tap on the TapRecorder icon to begin using it. Depending on where 
it was placed, on iPads and iPhones the TapRecorder icon might be 
on the main application screen, the secondary application screen (to 
the right) or within a folder.

On Windows devices, the TapRecorder icon will be on the desktop, 
but it is also available on the start menu or the apps page, depending 
on which version of Windows is being used.

When the TapRecorder starts up, it displays a list of saved Tap-
Recordings.  Tap on an existing TapRecording to select it, then tap 
on the Open button. To create a new TapRecording tap on the New 
button. Built-in TapRecordings are available by category, and can be 
accessed by tapping on the appropriate tab:
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Folder Tabs and Template Collections
Folder tabs provide easy access to collections of TapRecorder tem-
plates. The first tab is used to access all saved TapRecordings:

Tap on a folder tab to access the TapRecordings in that collection. 
To access PracticeStats, tap on the PracticeStats tab.

Note that it is no longer necessary to download and transfer Prac-
ticeStats because they are now built into the TapRecorder.
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Tap counts record the number of times a cell in the TapRecording has 
been tapped.  For example, a volleyball stat application for recording 
hitting performance might have a series of columns for kills, attack 
errors, etc. as well as columns which calculate hitting efficiency.  

Each time you tap on a cell it is incremented.  In this example the 
passes rated "3” for Player "1 Smith" have increased from 1 to 2.  Note 
that the passing average and related rating totals update automatically.  
The increment can be set to any amount, so that a basketball scoring 
application, for example, could have actual points for field goals and 
three point shots automatically recorded with a single tap.

TapRecorder Basics
The TapRecorder works like a spreadsheet with rows and columns of 
data. The TapRecorder differs from a spreadsheet because it has been 
designed for use on handheld computers with small displays using a 
touch screen rather than a keyboard for input. On Windows devices 
the mouse can also be used to click on the screen. 

TapRecordings differ from spreadsheets because all the cells in a col-
umn are the same type (except for subtotal rows).  The TapRecorder 
also has four special types of columns for data entry.

tap here ...

Tap Count Columns

and the data is incremented
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Choice lists present a list of alternatives from which a selection can 
be made with a single tap.  A typical application of the choice list 
might be a column which displays player position.  

For example, the second column, “Pos” has been defined as a choice 
list containing player positions.  To mark a player position, tap on 
the cell for that player in the Pos column, then select position from 
the list:

Other typical choice lists might be ratings of player performance, and 
sizes or types of equipment issued.

Choice List Columns
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Columns can be set up as check mark columns, where you record 
data such as attendance, unitforms turned in, etc. The first tap on a 
cell in a check mark column checks it. The second tap unchecks it. 

Check Mark Columns

Data Entry Columns
Data entry columns can be set up for entry of text, numeric, date and 
time data into cells.  Data is be entered using the on-screen keyboard. 
Text data can be entered in any format. 

Time should be entered as HHMMSS, where HH is hours, MM 
isminutes and SS is seconds. The TapRecorder will display the data 
as HH:MM:SS (the colon is not shown if it does not fit in column).  
Dates can be entered in any format.

Calculated Columns (see Column Properties)
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Recording and Pause Modes
Normally each tap on the screen increases the tap count, causes a 
prompt for text entry, displays a choice list or toggles the check 
mark in a cell. 

There are times, however, when you might want to select a series 
of cells and do a copy, erase, paste or insert. To do this, pause the 
recording by tapping on the Pause button. (Note that when record-
ing is paused there are different choices at the bottom of the screen.) 

Pause button

Record button

Then highlight the target range of cells by touching the screen and 
dragging across the cells to be selected. Then tap on the Copy but-
ton, select the upper left cell in the target range and tap on the Paste 
button. Turn recording back on by tapping on the Record button or 
by tapping on the "Paused" button at the top of the screen. 

Data can be copied from other applications via the clipboard, so a 
column of data can be copied and pasted from Excel into a TapRe-
cording on the Surface Pro tablet, for example.
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On the iPad you may copy data from Numbers (the Apple spreadsheet) 
or text from the Note application. On Windows devices you might 
copy data from Excel or from a text editor. To copy from Excel, 
highlight the range of cells and select Copy:

Switch to the TapRecorder, pause the TapRecording, highlight the 
beginning cell and tap on the Paste button:

Copying and Pasting Data (Excel example)
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Import: Instant TapRecordings
The next section, "Creating a New TapRecording" will go into detail 
about creating a TapRecording from scratch. The Import feature makes 
it possible to automatically create TapRecordings from text files or 
text copied to the clipboard (including text copied from web pages).

On the Open screen (or the New screen) tap on the Import menu item.

On the preview page select either Clipboard or Delimited Text File. 
and then the title and delimiter options:

Select Import on this preview screen to create the new TapRecording.
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Here's the result:

If the Import from option is Delimited File then you will also be 
prompted to select an available text file.
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Creating a New TapRecording
New TapRecordings are easy to set up and customize.  Tap on the 
New button on the TapRecording selection screen, or tap on the New 
button on the main TapRecorder screen:

iPad/iPhone

Windows PC or Surface Pro

TapRecordings can also be created from text data on the clipboard or 
in delimited text files. See the section Import: Instant TapRecordings.



16

Sheet Properties
Enter information to set the overall design of the TapRecording on 
the Sheet Properties screen:

iPad/iPhone

Windows PC or Surface Pro
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When you create a new TapRecording, make entries on the Sheet 
Properties screen to set up the initial properties, including the title, 
default column widths and initial number of rows and columns. You 
may also want to set the cell spacing to fit the most information on 
the screen.

Tap on the Done button when the properties are set up.

Note that you can access the properties screen to modify the properties 
of this TapRecording at any time by tapping on the title at the top of 
the page on the main screen.

The layout of the Sheet Properties screen on Apple devices (iPad/
iPhone) depends on which device is being used because of differing 
screen sizes. Items on the screen are also arranged slightly differently 
in portrait versus landscape orientations.

New TapRecordings are automatically set up with the first column 
(“row labels”) as a text entry column and the rest of the columns as 
tap count columns.  This can be changed by accessing the column 
properties of any column by tapping on the heading twice. (See the 
following section, "Setting Up Columns.")

The Spacing and Row height options set the size of the elements in a 
TapRecording. The Spacing affects the amount of space between the 
text in a cell and its borders, while the Row height affects the space
used for text, the font size and individual cell widths.
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Page Tabs
Use page tabs for quick navigation from page to page where you have 
more than 2 pages. This allows you to jump from page 1 to page 5 
with a single touch on the screen:

Once the overall sheet properties have been set up for the new Ta-
pRecording, modify the column property lists for each column so 
you can record data by taps, by data entry, etc.

Note: You can access the Sheet Properties screen at any time by tap-
ping on the title at the top of the main screen:

Gridlines put lines between cells. The Summary row is an automatic 
total at the bottom of a TapRecording. Suppress zeroes causes blanks 
instead of zeroes to be displayed.

	 iPad/iPhone			  Windows
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Column Properties
Tap twice on a column heading to edit the column properties. Note: 
if the column heading is blank you will be prompted to enter it..

To change the name of the column, edit it in the text box at the top 
of the screen or on the top of the Column Properties sheet.

Select Tap, Input, Calc, Choice, or Check as the column type.  

Tap on Number, %, Text, Date, Time or Check Mark to select the 
format for this column.  Formats and other column options will be 
hidden if they don’t apply to this column type.

Column
Heading

iPhone
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Column properties also include column width, number of decimals, 
text alignment and whether or not to include in the Summary Row 
totals (numeric columns only).  

Additional properties include Show/Hide, "Count By" (Tap count 
columns only) Subtotal Level (text columns only) and the "All 
Pages" option. 

Each of these properties is described in the following sections.

Windows
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Columns can be hidden, something you might want to do with inter-
mediate calculation columns which you don’t want to see.  Hidden 
columns (and rows) can be unhidden by tapping on the Options  button 
and selecting Unhide Columns from the Options screen.

Show/Hide Column

Subtotal Level: Column-Based Subtotals
In some TapRecording applications it is useful to subtotal several 
groupings of rows.  A typical example would be statting a beach 
volleyball game where you want to keep track of stats for each of 
two teams.  

To do this, set up a column named "Team", which might be a drop-
down choice list of either "1" or "2". Use the Subtotal level option to 
specify that this column is to be used as a level 1 subtotal:

Team Column Team Subtotals
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Show Column on All Pages
The All Page option is used to show identifying information on each 
page of a multi-page display.  

For example, you may want to show the first column, Player, on each 
screen when doing stats.
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Tap Count Columns

Column types are the heart of any TapRecorder design. Select the 
column type on the Column Properties sheet:

Column Types

Tap count columns are the most common column type. Unlike Excel, 
where a lot of effort is required to simply count in a cell, counting 
in the TapRecorder is easy. Just tap in a row in a Tap Count column 
and the value in the cell will increase by one.

Tap counts can count by any numeric amount and that can be set by 
an entry in the CountBy field:

Text Entry Input Columns
TapRecordings typically have a text input column as the first col-
umn. It might be roster player name, product name or some other 
descriptive text. 
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Text Entry in a Cell
Tap on any row in a text entry column to enter text. Note that the 
on-screen keyboard pops up for text entry whenever you tap on a text 
entry cell, unless your device has a built-in keyboard.

Important note: The cells in the first column on a page are special. If 
you tap in the right side of the cell it selects the cell (typically for data 
entry). If you tap in the left side of the cell it selects the entire row. 

On screen
keyboard

Text Entry: iPad/iPhone
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Tapping a second time on a selected row brings up the row properties 
screen where you can change the name and hide (or show) a row:

Text Entry: Windows PC
Tapping on a text entry cell on Windows brings up a dialog box 
where you can edit the entry. (Again, note that you tap on the right-
hand side of the text cell to edit it and you tap on the left-hand side 
to highlight the entire row).
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Choice List Columns
To set up a column as a Choice list column, select the column type 
“Choice”, select “Text” format, then enter the choices to be used 
separated by commas. using the keyboard which pops up.

The Choice list can be used to make an entry for that cell with one 
tap to select an entry from the list.



27

Calculated Columns
Calculation formulas are used to calculate values in columns. To cre-
ate a column representing volleyball hitting efficiency, for example, 
select the Calc Type and specify 3 Decimals. 

 Use the Show Columns button to display the column list and enter 
column references. Enter arithmetic symbols using the +, -, x, /, and 
parenthesis buttons. Formulas can also be entered using the on-screen 
keyboard.

Enter the formula (C3-C4)/(C3+C4+C5) in the formula field. (Hitting 
efficiency is kills minus hitting errors divided by total attacks).
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Saving a TapRecording
Save the TapRecording by tapping on the Save or the SaveAs button 
at the bottom of the screen:

Save As with Patterns for Title, Date and Time
Use the SaveAs button to save the current TapRecording under a 
dif﻿ferent name.

Often a TapRecording is used to record daily events, and you may 
want to save each day's TapRecording under a unique name.  The 
Save As Patterns in the TapRecorder let you to save a TapRecording 
under a name which is qualified by date, by time or both.  It can also 
be used to link the name under which a TapRecording is saved to the 
title of the TapRecording.
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To use the Save As Patterns, select one of the patterns, or "*" to do 
a custom pattern.  The TapRecorder replaces the "&Title" with the 
current title, replaces "&Date" with the current date and replaces the 
"&Time" with the current time.  Tap on the "*" Alternate pattern or 
tap on the Edit button to set up a custom pattern:

Once the pattern has been entered, tap on Done on the keyboard, then 
tap on the Done button, then tap on the OK button.
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Sorting Rows By Column Value
Sometimes you may want to reorder the rows in a TapRecording. For 
example, you may add players to an existing roster or you may want 
to look at the data based on the statistics which have been recorded.

To sort the rows in a TapRecording you start by hitting the Pause 
button at the upper left of the screen. Then tap on the column head-
ing of the column to be sorted on and hit the Sort item at the bottom 
of the screen:

The rows will be reordered based on the column. (To sort in reverse 
order hit the Sort button a second time). Tap on the Record button to 
continue recording data.
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Send Options (iPad/iPhone)
The Send option in the TapRecorder toolbar provides a means to 
email TapRecordings, copy TapRecording data to the clipboard, 
and to send TapRecordings to an external printer (iPad/iPhone). 

Access the Send options by tapping on the Send button at the bot-
tom of the screen:

When you tap on the "Send" button in the Toolbar, a new "Send" 
Toolbar appears:

Toolbar

Send Toolbar
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Send Toolbar

The Print (Prn) and Email (Email) options send a copy of the 
report image either to a printer or to an email recipient.
 
Note that printer output is only available if there is an "ePrint 
enabled printer" accessible to the iPad via a wireless connection. 
Many new printers are now ePrint enabled. Note that an ePrinter 
requires a wireless network be available to communicate with an 
iPad/iPhone. 

If Print is selected, the iPad/iPhone will search for available print-
ers and let you choose which printer to use.

Email must be activated on the iPad/iPhone for email options to 
work. This is done in the Settings app using the "Mail, Contacts, 
Calendars" tab. 

The appearance of the email confirmation screen depends on which 
email service is being used on the iPad/iPhone, but it may appear 
as:



34

The Clipboard options (Copy, CSV) copy TapRecording data to the 
clipboard so it can be pasted into other apps. The regular Clipboard 
option (Copy) copies all of the TapRecording as text and numbers 
to the clipboard. 

The CSV Clipboard (CSV) option puts data values and formulas 
onto the clipboard. Data which has been put on the clipboard as 
CSV data can be pasted into other spreadsheet apps on the iPad/
iPhone, such as the Numbers app from Apple. 

The CSV email option (EmCSV) sends CSV data to an email 
recipient, where it can be downloaded and opened by a spreadsheet 
on another platform (such as Excel on a PC or a Mac). 

The send Data File option (Data) sends an actual saved TapRecord-
ing data file to an email recipient as an attachment. 

See the section, "More About Formatted CSV Data", which fol-
lows the next section on exporting from Windows devices.

Tap on Send button to send the email.
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Print and Export Options (Windows)

The Text clipboard option copies TapRecording text and values to 
the clipboard to be pasted into text processing applications.

The Formulas clipboard option puts data values and formulas (in 
"CSV" format) onto the clipboard. Data which has been put on the 
clipboard as values and formulas can be pasted into other spread-
sheet applications on Windows such as Excel with formulas intact.

There is no separate Email function within the TapRecorder for 
Windows. If you wish to email TapRecording information from 
Windows, use the File export option to create a data file, then send 
that data file as an attachment to your normal email software. You 
can also send saved TapRecording files as attachments.

The following section has more information on exporting formulas 
(CSV).

The TapRecorder for Windows has Print and Export buttons on the 
main screen instead of a Send button like the iPad. Use the Export 
button to send one of several different kinds of data from the 
TapRecorder to other applications. Use Print for hard copy output.
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is copied to the clipboard as CSV data, then it can be pasted into 
Numbers (on the iPad) or Excel (on Windows) as:

More About Formula (CSV) Data
Note that the "CSV" format provides formulas for cells where the 
TapRecorder does a calculation. The complete TapRecording can 
then be opened in a spreadsheet tool and the calculations will still 
work. For example, if a TapRecording which appears as:
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Important: Keep in mind that these processes simply copy the data. 
If the TapRecording changes, the data will need to be transferred 
again.

Also note: Most spreadsheets will mark a cell as "division by zero" 
if a formula divides anything by zero, since the resulting value 
is not a valid number. This differs slightly from the TapRecorder 
which puts a blank (or zero) in the case of zero divided by zero.

Note: The examples on the previous page were truncated for 
readability. Also note: formula (CSV) data must be pasted into the 
upper left corner of the target spreadsheet so that the formula refer-
ences work properly. 

Once the TapRecording data has been pasted into the target app, 
then additional rows and columns can be inserted and the formulas 
will be adjusted accordingly.

Emailed TapRecordings sent as formula (CSV) data can be used on 
desktop computers by downloading the email attachment, saving 
the file and then opening it with a spreadsheet.

For example, when the CSV file is downloaded and opened in 
Excel it might appear as:
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TapRecorder Options from Main Screen
Some TapRecorder features are accessed using the Options screen.  
Tap on the Options button on the main screen to use these features.

	 iPad	 			   Windows
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Note that row and column properties can also be edited by double-
tapping on the row or column to be edited.

To insert rows and columns it is best to pause the TapRecording (Hit 
the Pause button in the upper left-hand corner of the screen), then 
highlight the row or column, then tap on the Insert button at the bot-
tom of the page, rather than using the Options button.

Select Hide Rows/Columns to suppress display of "hidden" rows 
and columns.  Select Show Rows/Columns to reveal hidden rows 
and columns.  

Use the About option to see software version and serial number.

The next page describes how to insert information from existing 
TapRecordings so you can set up lists of player names on a roster 
or other commonly-used columns and easily copy them into a new 
TapRecording.
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Insert From TapRecording Library
This option simplifies copying data from existing TapRecordings. 
Select the "Insert TapRecording ..." option from the Options menu 
and select the TapRecording to be copied:

When you tap the Copy button, all of the columns on the selected 
TapRecording will be copied into the current TapRecording.

The remaining sections of this User Guide describe how to move data 
to and from the iPad/iPhone and the desktop. They also describe how 
to consolidate TapRecordings using the TapRecorder Consolidator 
on desktop Windows computers.
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Moving TapRecordings to/from Desktop
TapRecordings can be moved back and forth between the iPad/
iPhone and a PC or Macintosh using iTunes File Sharing. For newer 
Macintosh computers, iTunes may not be available and files should 
be moved using the Files option of the Mac Finder. 

For Windows PCs you may need to download and install iTunes for 
Windows. Note that TapRecordings on Windows PCs can be moved 
to other devices via network drives, flash drives or any other standard 
mechanism. To move files from a PC to an iPad/iPhone however,  
you should use iTunes.

Note: The Send button on the iPad/iPhone main screen can also be 
used to  send TapRecordings to a PC or a Macintosh via email.

Connect the iPad/iPhone to the desktop with the Apple USB cable, 
turn the device on and enter the security code to unlock it. Run the 
iTunes application on the desktop (it usually starts automatically). 

Click on the name of this iPad/iPhone at the left of the screen. If the 
iPad/iPhone is set to automatically synchronize with this computer 
you may have to wait until the sync process is complete.

Moving Files with iTunes

Then click on the small rectangle (toward the upper/middle part of 
screen) to select this iPad/iPhone device.
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 On the display which appears, click on "File Sharing". When the 
apps which use file sharing appear, tap on "TapRecorder".  This will 
display a list of all TapRecordings saved on the iPad/iPhone. 

To move TapRecordings to the desktop from the iPad/iPhone, select 
them on the right side of the screen. (You can use shift-click to select 
ranges and control-click to select them one at a time.)

When you have selected the TapRecordings to be copied to the desk-
top, click on the “Save ...” button (bottom right). Browse to the target 
folder on the desktop and click on OK and they will be copied. Note 
that iTunes copies files very quickly.
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Sometimes you may want to move TapRecordings from the desk-
top PC or Mac to your iPad/iPhone. This is useful when you have 
copied TapRecordings from a different iPad/iPhone or when you 
have developed TapRecordings on the PC using the TapRecorder 
for Windows. 

To move TapRecordings from the desktop to the iPad/iPhone, click on 
the "Add File ..." button. Browse to the folder on the desktop where 
the TapRecordings have been saved. Select the TapRecordings to be 
moved, then click on the Open button.

Moving Files with the Macintosh Finder
Newer versions of the Macintosh OS do not include iTunes File Shar-
ing features. Instead, you should use the Macintosh Finder. 

Connect the iPad/iPhone to the desktop with the Apple USB cable, 
turn it on and enter the security code to unlock the device. Run the 
Mac Finder and tap on the name of the iPad/iPhone on the left-hand 
side of the screen:
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Tap on the > (expand) symbol next to TapRecorder to see all of the 
TapRecording files. (There will be a few extra utility files also.) 
TapRecordings will have a ".tpr" extension. 

Now open a second Finder Window adjacent to this one on the Mac 
desktop and navigate to the folder where you would like to move the 
TapRecordings. (Only if not already on Desktop.) Now select the 
TapRecordings in the first window and drag and drop them into the 
folder in the second window to move them.

drag and drop to
   target folder
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Consolidating TapRecordings
TapRecordings can be consolidated on Windows and Macintosh 
laptop/desktop computers using the Consolidator II application.

Consolidator II works with spreadsheets like Excel, but it is a regu-
lar Windows and Macintosh desktop application. It puts results on 
the clipboard for pasting into a spreadsheet or it can create "CSV" 
files which can be read by a spreadsheet. Because it is a stand alone 
application, Consolidator II requires that you move back and forth 
between it and Excel.

Consolidator II replaces the "Excel Macro Consolidator" which was 
an all-in-one Excel worksheet for consolidation. It included "macros" 
to perform the consolidation functions and put results into cells in the 
worksheet. When the Macro Consolidator works, it works very well. 
And because the Macro Consolidator is an Excel workbook, you can 
save your consolidation all in one spreadsheet. 

The Macro Consolidator, however, has several very serious draw-
backs. Almost every version of Excel which has been published has 
changes in how it handles macros. In fact, at one point macros were 
completely removed from Excel on the Macintosh. Worse yet, newer 
versions of Excel require that "libraries" be added into Excel to enable 
many macro functions. See the following section, "Adding Missing 
Libraries to the Macro Consolidator" for details.

The challenges of getting the correct libraries enabled in Excel have 
put the Macro Consolidator into a class beyond the capabilities of the 
normal user. Additionally, Consolidator II works on the Macintosh 
while the Macro Consolidator does not. 
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Running Consolidator II

The Consolidator II makes it easy to access and consolidate TapRe-
cordings. The results are then used in a spreadsheet like Excel by either 
pasting them from the clipboard or opening them from a CSV file.

On Windows PCs run Consolidator II from the Start menu (actually 
the menu formerly known as the Start menu), by tapping in the lower 
left corner of the main screen. Scroll down to "TapRecorder Consoli-
dation" and select Consolidator II. On Windows 8 and 8.1 systems, 
access Consolidator II from the Applications Panel:

Windows 10, 7 and earlier	 Windows 8 and 8.1

On Macintosh computers run Consolidator II from the Applications 
folder (or wherever it was installed):
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Running the Excel Macro Consolidator
The Excel Macro Consolidator makes it easy to access and consolidate 
TapRecordings. It is an Excel workbook which uses Excel macros. 
Consolidated results are put into cells in a separate worksheet within 
the workbook. Note: Available for Windows PCs only.

Run the Macro Consolidator by tapping in the lower left corner of the 
main screen. Scroll down to "TapRecorder Consolidation", tap on that 
entry and select the approprkate Macro Consolidator to match your 
version of Excel. On Windows 8 and 8.1 systems, access it from the 
Applications Panel in the "TapRecorder Consolidator" section:

The Excel Macro Consolidator for the TapRecorder often fails to run 
because of incompatibilities in different versions of Excel. In particu-
lar, the "libraries" required for the macros which do the consolidation 
are not activated by default. You may see a message such as:

	 Missing library ....

In this case you may choose to use Consolidator II instead.

Problems with missing libraries can only be resolved by making 
changes in Excel to enable the required libraries. See the section, 
"Repairing Macros for the Macro Consolidator", which follows.

Windows 10 and Windows 7 Windows 8
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Using the Consolidators
Consolidator II and the Macro Consolidator use similar interfaces:

Consolidator II

Excel Macro Consolidator

For Consolidator II, enter a name in the Consolidation Name field 
under which text and CSV files will be saved as results. Note that 
the Macro Consolidator stores results on a separate worksheet in 
the same workbook.
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Consolidator Styles
The Consolidators import TapRecording data which can then be 
output in a variety of styles.  

The Import/Consolidation Styles let you import TapRecordings as 
individual figures into their own range of cells ("Standard spread-
sheets"), consolidate them into a single range of cells ("Consolidated 
spreadsheet") , or list them as columns of data ("Tabular data").  Note: 
If you choose the "Consolidated spreadsheet" option make sure your 
TapRecordings have the same alignment of rows and columns. Con-
solidator II does not implement Spreadsheet and Tabular styles yet.

Place the data wherever you want using the "Insert At:" cell reference 
(the default is A1). It is important to properly identify the beginning 
target cell because any formulas must be adjusted to be correct. 

Check "Clear All Cells on Result Sheet" to erase entries from previous 
consolidations.  Be careful to uncheck this box if you have custom-
ized the figures and/or formulas on the Result sheet and do not want 
to overwrite them.

Placing Results and Formulas Using Insert At
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Selecting TapRecordings with Browse
TapRecordings can be saved in any valid folders on the desktop. 
When you consolidate TapRecordings you must tell Consolidator II 
or the Macro Consolidator which folder to access.  

Click on the Browse button and use the PC and/or Mac folder naviga-
tion to select the folder containing your TapRecordings. When you 
find them, select any one of them and click on the Open button. Note 
that using Consolidator II you select the folder and not a TapRecord-
ing. 

If you have trouble finding your TapRecordings, use the Search feature 
of your desktop computer and look for files with a "*.tpr" pattern.

Consolidator II

Macro Consolidator
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Select TapRecordings to be consolidated by clicking on them in the 
list of Available TapRecordings on the left, then click on the Add but-
ton.  Note that you can shift click to select ranges and control click 
to select files which are not next to each other in the list.

Click on the Process/Import button to read data from the selected 
TapRecordings and create the results.

Consolidator II

Macro Consolidator
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Consolidator II Output

Use the Smaller/Larger Font buttons to improve visibility in the 
display.

One more step is required in Consolidator II to actually export the 
consolidated results. Click on the Text File Export, CSV Export or 
Copy to Clipboard buttons to output the results. Note that Text File 
Export exports results in a format which can be used in text editors

When Consolidator II consolidates the TapRecordings it shows a pre-
view of what the data will look like on the clipboard and in Excel.

The output screen has Show Values and Show Formulas buttons which 
control how data is exported. To have figures calculated when the 
results are exported to a spreadsheet like Excel hit the Show Formulas 
button. Note that the alignment in the Preview is not correct because 
of the formulas, but the actual exported data includes tabs so it will 
work correctly. 
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and word processors. CSV Export is what you would 
commonly use to create a file which can be opened by 
Excel. Copy to Clipboard is an alternate way of export-
ing data which puts the results on the clipboard. Data 
on the clipboard would be pasted into a spreadsheet or 
text editor. 

Here's what it looks like when you export a CSV file 
and then open it in Excel:

Note that outputting results to the clipboard and then 
pasting them into Excel has similar results. Also note 
that exported files are output to the same folder as the 
TapRecordings and under the name entered on the Con-
solidation Name field.
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Macro Consolidator Output

The consolidation results can be used in formulas in other cells and 
otherwise manipulated any way that spreadsheet data can be used.

Use the Excel menu item, File-Save As ..., to save each Macro Con-
solidator worksheet under a unique name.

When the Macro Consolidator exports consolidation results they 
are put onto a second worksheet within the Excel workbook.
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Repairing Macros for the Macro Consolidator
It is unfortunate that the many changes in different versions of 
Excel and the elimination of  some "libraries" and other macro 
features have made spreadsheets which use macros problematic. 
The TapRecorder Macro Consolidator is one such example. If you 
get an error message such as:

		  Missing or Invalid Library

when you open the Macro Consolidator in Excel, you have encoun-
tered this problem. Note that the libraries are not really "missing", 
in most cases they just need to be activated in Excel.

Activating the libraries is not very difficult, but it is a bit technical. 
Note: These illustrations will be for Excel 2016 on the PC. Other 
versions may work differently. If you follow these directions and 
have a problem, use the web to search for better instructions.

There are two steps you need to take to activate the libraries. First, 
you need to enable the "Developer Tab" in Excel. The Developer 
Tab is not visible in Excel by default, so it usually needs to be 
added to the ribbon at the top of the screen. If it is already on the 
ribbon (the row of items across the top of the screen labeled, "File 
Home Insert ...") then you can skip this step.

Developer Tab
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File Tab

To add the Developer Tab to the ribbon, from within Excel click on 
the File Tab and then select Options 

Options
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After selecting Options from the File menu, click on Customize 
Ribbon from the File Options menu. In the left panel select "Devel-
oper" then click on the Add button to move it to the right panel. 
Click on the OK button to return to the main Excel screen. The 
developer tab should now be available. This completes step 1.

The second step is to include the missing libraries. To do this click 
on the Developer tab then click on the Visual Basic icon at the far 
left:

Developer Tab

Visual Basic Icon

Customize Ribbon Developer

Add
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Next, click on the "Tools" item on the Visual Basic for Applica-
tions menu. Then select "References" from the drop down list.

Scan the list of Available References" from the drop down list and 
check on each of the five libraries checked below. Then click on 
the OK button.

This completes the process. The Excel Macro Consolidator should 
now run without a problem.

    
    Visual Basic for Applications

    Microsoft Excel 16.0 Object Library

    Microsoft Forms 2.0 Object Library

    Microsoft Office 16.0 Object Library

    Microsoft Common Dialog Control 6.0 SP6

    Microsoft Office 16.0 Object Library

Click on File menu and select "Close and Return to Microsoft 
Excel".

Tools References
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The TapRecorder Desktop Designer (obsolete)
 The TapRecorder Desktop Designer has been replaced by the TapRe-
corder for Windows.TapRecordings can be set up and tested using 
the TapRecorder for Windows, then transferred to iPad/iPhone and 
Windows Surface Pro tablets. 

The TapRecorder for Windows can be ordered directly from Dimen-
sional Software using our web site, "www.taprecorder.com".
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